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Introduction

VbReader is an off-line reader program written in Visual Basic and intended to
provide a simple and reliable off-line reader for the average user, in a Windows
3.1 environment.

The program processes mail packets conforming to the Quick Mail format.

It incorporates the features needed to unpack mail packets, read the messages,
write replies and generate a mail packet containing the replies. The interface
was designed to be simple and easy to understand and use.

Users of this program will require a communication program to perform the
download and upload of mail packets to the bulletin board of their choice.

This program is "Freeware". Registration is not required. The author would like
that users send him Email at the following address, to comment on the program,
suggest improvements, etc. The author intends to be very responsive to user
requests.

Send Email to:
daniel.page@canrem.com
or
Daniel Page, user at Canada Remote Systems BBS
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Requirements

The user requires the following:
- Windows 3.1
- Pkzip and Pkunzip data compression software
- Communication program
- VGA or better video monitor (800x600 resolution preferred)
- Although the program will run on a 286, a 386 is preferred

Installation

-Create a directory on your hard drive. Name it READER or some other
appropriate name. For example:

md c:\reader

-Copy the reader.zip file to this directory. Make this directory your current
Directory. Unzip the distribution file: (pkunzip must be in your path)

copy a:\reader.zip c:\reader

cd \reader
pkunzip *.zip

-The distribution file contains the following files:

reader.exe
vbrun100.dll
dandil.dll
threed.vbx
news.bat
news.pif
welcome.bat
screen
welcome.pif
explode.pif
compress.pif
85140em.fon
vgaoem.fon

; VbReader Program
; Visual Basic Dynamic Link Library
; Custom Dynamic Link Library
; 3d Controls VB extensions
; Batch file to display bbs news bulletins
; Pif file to display bbs news bulletins
; Batch file to display the bbs welcome

; pif file to display the welcome screen
; pif file to launch pkunzip

; pif file to launch pkzip

; Large Terminal Font

; Small Terminal Font
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Additional Files:

services.pif ; Sample Pif file to display the services data
files.pif ; Sample Pif file used to launch the files display editor
tagfile.txt ; text file containing tag lines

- Invoke the Windows Fonts installation program from the Windows Control
Panel. Choose the Add option. Direct the program to search in the reader
directory. It will display the following: Terminal font for the IBM 8514 and
Terminal [US] [Set #6]. Click on the two fonts to select them, then click the
OK button. The fonts will be installed. If the fonts are already installed in
your system, windows will display a message to that effect. You may then
cancel the installation of the new font.

NOTE: In order to function properly, the program requires that
BOTH fonts be installed.

- You may wish to copy the *.dll files and the *.vbx files to your windows\
system directory, although the program will function without this step. If you
do copy those files, you may delete them from the reader directory. Copying
those files to your system directory will allow other Visual Basic programs to
use them.

- In order to properly display the ANSI graphics that are usually included in the
Bulletins files from the BBS, you must load the ANSI driver provided with your
dos operating system. This is done by editing your config.sys file. Add the
following line:

device=c:\dos\ansi.sys

- In order to allow VbReader to invoke the Pkzip and Pkunzip utilities, the
location of those files must be in your Path statement in your autoexec.bat
file. Alternatively, you may copy those utilities directly in the reader directory.
An other option is to modify the pif files to point to the proper directories.

- Add the reader.exe program to a program group in the windows program
manager.

-This completes the installation.

- If you edited your config.sys or autoexec.bat files, reboot your system to
allow the changes to take effect.
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Initial StartUp of VbReader

To start VbReader, you may double-click on reader.exe with the file manager, or
double click on the icon in a program group.

Initial Configuration
When the program is first started, it will look for a configuration file
(reader.ini). Initially, this file will not exist. The program will then invoke the
configuration menu. The following options should be verified and adjusted to
your needs:

Paths and Directories
Examine the Directories listed. The defaults provided should be
adequate. If you have specific upload and download directories for your
communication program, you should change the uploads and download
paths to those directories so that VbReader will be able to access mail
packets directly from the communication program's directories.

Fonts
Two font choices are provided: small font and large font. The small
font is suitable for full screen viewing in systems using VGA resolution.
The large font is intended for full screen viewing in systems using Super
VGA (or better) resolution. In such systems, the small font may be used
when the program is used in windowed mode.

Colors
The color options allow you to choose background and foreground colors
independently of each other. These colors are used for the display
screen, and the list boxes. Click on the desired colors and the result is
displayed in the sample text box to allow you to judge the result.

Once you have configured the options, click the Done button. The program
will proceed to create the required directories listed in the configuration
menu. The program will notify you for every directory created. Just click
the OK button until the mail screen is displayed. We are now ready to open
a mail packet. However, before we do, you should invoke the second
configuration menu.

Complete Configuration
Click on the Quick Configuration menu item. The second option listed is
the TagLine option. Clicking on this option will invoke the second
configuration menu. This menu allows you to modify the following options:
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Your Name:
This option sets your user name. This is used when entering replies or
new messages.

Your Tag Line:
This is your default tag line.

Tag File Name:

The name of a file containing tag lines. This file must reside in the
directory listed in the first configuration menu. VbReader comes with a
file containing 4500 tag lines. This file should be moved in the TagLines
directory, or the TaglLines directory should be changed to point to the
location of this file. By default, the file name is Tadfile.txt. You may
change this to any name you wish. Just make sure that you tell
VbReader the correct location and name of the tag file, via the
configuration menus.

Your Signature Lines:
This text box contains the signature text which will be appended to the
end of the messages you write.

Default BBS ID:
Finally, this menu allow you to specify a default BBS name.

After having set those options, click Done and the program returns you to
the main screen.

Now select the third item in the Quick Configuration menu, Editor
Selections. The following options are displayed:

Files List Editor:
This option allows you to select the editor which will be used to display
the new files list downloaded from the BBS. The default is the WRITE
program shipped with windows. You may specify your favorite editor. [f
this editor is a Windows based editor, you need only specify the program
name. If the editor is not in your path, you must include the full path.
ex: deskedit.exe
or
c:\ndw\deskedit.exe

If the editor is a DOS application, it is best to insert the name of a PIF file
which will supply the required parameters to Windows in order to launch
the editor. Normaly, this pif file will contain the name of the editor and
will launch the editor in Windowed mode. See the example pif files
provided (files.pif and services.pif).
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Services Editor:
This editor s7
election is used to display the services data files downloaded from the
BBS. See the files editor selection above for details in configuring this
option.

Now return to the main configuration menu. Click on the forth item, Fido
Mode.

FidoMode:
This option changes the tear line characters to a string of character
which FIDO bbs systems will allow. When this option is OFF
(unchecked) the reader is PC Board mode, the normal mode.

Mode Francgais
This mode will change the quote line used when replying to a message.
When it is checked, the quote line is in French. To change the Keyboard
to french mode, use the Control Panel, International option.

We are done with the configuration. Do not forget to click the last option,
Save Configuration to Disk.

Opening a Mail Packet

Click on the File menu. At this point, two items are enabled: Open Mail
Packet, and Create Replies Packet. Click on the Open Mail Packet item.
The program will look in the work directory for existing data. If you previously
had opened a mail packet, the work directory would contain files. At this point
the program would ask you if you wished to purge the directory. However,
since at this time you do not have any data in the work directory, the program
will directly invoke a file dialog box. The box will display the contents of the
download directory. Select a mail packet.

Once a mail packet is selected, the program will launch Pkunzip in a dos
window. The packet will be expanded and the files installed in the work
directory. Once the expansion process is complete, you may read the
messages.

Reading Messages
Click on the View Items menu option. A list of options appear.

Personal Mail
Clicking on this option will cause the program to search for personal
messages. If any exist, a list will appear, listing the message dates,
originator, destination (you) and the subject. Double-click on the desired
message to view it. Or use the Arrow keys or Page Down or Page Up
keys to select a message and press Enter to view it.
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Join Conference

Clicking on this item will cause a list of conferences to be displayed. The
program will display only conferences in which there are messages to
read. The list also displays the number of messages in each conference.
Double-click on the desired conference. At this point, a list showing the
available messages is displayed. Like the Personal Messages list, it
displays the Subjec, Message Number, originator, destination and the
message index number. Double Click on a message to view it., or use
the Arrow Keys, PageDown or PageUp Keys followed by ENTER.

New Files
This menu item will cause the program to invoke the editor program
selected in the Files Editor configuration option. The default is
Write.exe, the editor bundled with windows. The editor will then display
the list of new files which is usually included in your mail packet. While
in the editor, you may search for topics, edit the file, and generally use
normal editor functions.

BBS News
This option will launch a dos window and will cause the bbs News file to
be displayed in this window. If the news file contains ANSI colors and
graphics, those will be displayed, provided that ansi.sys is loaded in
your config.sys file. At any time, you may interrupt the display by typing
cntrl-c.

Services
If services were include in the packet, a list will appear listing the
services included in the mail packet. You will then have to manualy
launch an editor, and/or pkunzip to process the service. The next version
of the program will process services fully.

Welcome Screen
Like the BBS News menu, this option launches a dos window and
displays the BBS welcome screen, if this screen was included with your
mail packet. Again, you must have ansi.sys loaded to allow colors to be
displayed. After the screen is displayed, type <enter> to close the
window.

Goodbye Screen
Like the BBS News menu, this option launches a dos window and
displays the BBS goodbye screen, if this screen was included with your
mail packet. Again, you must have ansi.sys loaded to allow colors to be
displayed. After the screen is displayed, type <enter> to close the
window.
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Managing the Reader Screen
Once in the read screen, you may select messages to view by one of two
methods, mouse or keys.

Mouse Method
First, you may use the horizontal scroll bar at the bottom right of the
screen. Clicking on the buttons at either end will select the next or
previous message in the conference. Clicking on the scroll bar will
increment or decrement the message pointer by larger amounts (total
number of messages / 10). You may also click on the "thumb button"
and drag it left or right, thereby selecting messages.

Keys
For faster control of the screen, you may use the arrow keys. The up
and down arrow keys will scroll the view screen up and down by a full
screen. The left and right arrows will select the previous and next
message respectively.

Note that for the keys to function as expected, the scroll bar must have
the focus. Should the keys cease to function as expected, use the
mouse and click on the scroll bar to restore the focus to that control.

Under the scroll bar, you will see a button labeled Message List. This button
will display the message list, where you may select a message by double
clicking on it, or by pressing the ENTER key.

Note that all controls displayed in the reader screen have ALT Keys assigned
to them. Each control has an underlined letter in it's caption. To activate a
control, Press the ALT key and the underlined letter.

Entering a Reply

Starting the Process
While reading messages, you may enter a reply by clicking on the Reply
button. At this point, the program will ask if you wish to include the
message in your reply. If you answer yes, the program will copy the
message to the edit screen and include quote marks and a quote
announcement at the top of the message. Otherwise, the reply screen will
be shown empty.

Controlling the reply destination
Normally, the reply is automatically addressed to the person whose name
appears in the From: field at the bottom right of the read screen. In most
cases, this is adequate. However, in some cases, you may wish to address
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your reply to the person who started the subject thread. In such cases, you
may re-direct the reply by doing the following:

Before pressing the Reply button, use the mouse and select the name of
the person in the TO: field at the bottom right of the reader screen. Like all
windows programs, you select the name by a "Click and Drag" operation on
the field. Once the name is selected, copy it to the clipboard by typing
<cntrl Insert>. Invoke the reply screen and paste the new destination over
the TO: field by selecting the name (Click and Drag) and typing <Shift
Insert>. You may also need to modify the quote line at the top of the
message, depending on the context.

Should you wish to send this reply to a person whose name is not displayed
anywhere, just type the correct name in the TO: field.

Setting the message security
The message you enter may be either Private or Public. When private,
only the recipient may read it. When public, anyone in the conference will
be able to read it. The security level is set by clicking on the appropriate
radio button control at the bottom of the screen.

Other Displays
At the bottom of the reply screen you will note a number of display fields.
They are used to display information about your message. This includes
the conference number, the time and date of your message, and the
message number of the message you are replying to.

Editing Commands
The editor is not very complex but quite functional. You may use the mouse
to move the cursor to any insertion point in the text. The mouse will also
allow you to select text by doing a Click and Drag operation.

Once text is selected, you may delete by using the delete key, or cut or copy it to
the clipboard by using the Edit menu. Once text is in the clipboard, you may
paste it to another location. As a short cut, you may use the cntrl Inse10
rt and shift Insert key strokes to copy text to the clipboard and to paste it
back in your message. The clipboard mechanism also allows text to be

transferred to and from other applications.

The text will automatically wrap at the right edge of the screen. Using the
enter key will move the insertion point immediately to the next line.

Tabs are inserted by typing the cntrl Tab key sequence. That is because
the Tab keystroke is used to navigate between screen objects and controls.
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File Commands
While in the editor window, you may save the displayed text or insert a text
file in the editor window by selecting the appropriate option in the File menu
in the menu bar.

Tag Line Selection

Once your message is complete, you may wish to select an appropriate tag
line. At the bottom center of the screen, you will see a button marked Tag
Line. Clicking on this button will invoke the tag selection window. This
consists of a drop-down list box. When first invoked, the list box displays
the current tag line. Clicking on the arrow button on the right of the text box
will cause a list of tag lines to be displayed. If the number of tag lines
exceeds the area available to display them, a scroll bar will also appear.
Select the desired tag line by clicking on it. Click on the OK button to return
to the edit screen. Note that the list box can only display the first 1000 tag
lines in you tag file. Also Note that the tag line is not displayed in the edit
screen. It is appended to the end of your message when you save it.

Saving the message
When you are done with the editing, click on the Save button. A dialog box
will appear asking you to confirm. If you confirm that you wish to save the
message, the message will be appended to the reply file in the replies
directory. If you select Cancel, you will be returned to the edit screen.
Clicking the NO button will delete the reply and return you to the read
screen.

Entering a New Message
You would use this option when you wish to enter a new message, not linked
to any particular message in a conference. The procedure is very similar to
the Reply procedure except for the following:

Selecting a Message Conference

When entering a new message, you may explicitly declare which
conference your message in intended for. You may either type the
conference number in the appropriate field at the bottom left of the editor
screen, or you may pick a conference from a list that is displayed when you
click the Display Item menu item in the menu bar at the top of the screen.
When the list is displayed, select a conference by clicking on it. Note that
the list will only display the first 3000 conferences listed in the mail packet
control file.
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Selecting a Recipient
To address the message to a recipient, simply type the person's name in
the TO: field at the bottom right of the edit screen.

Editing Your Replies
Before sending your replies to the BBS for everyone to read, you may wish to
read them and perhaps edit them. This can be accomplished with the Your
Replies menu option.

Clicking this option will bring up a list of your replies. Double-click on the reply
you wish to read. It will be displayed in the Read window. The Replies feature
works in the same maner as the Read Messages mode.

When the editing of replies is complete, pressing the DONE button will cause
the old replies to be erased and a new reply file created with the newly edited
replies.

Creating a Replies Packet
Select the Create Replies Packet option of the Files menu. This will launch
the compression program which will compress your replies and move the
resulting file to the uploads directory. You will be asked if you wish to delete
the old replies (the ones that are now being processed). If a mail packet
exists in the upload directory, the program will ask whether you wish to
continue. If you continue, the old replies packet will be overwritten.

Once your reply packet is created, launch your communication program and
upload it.

VvReader Limits:
Number of Conferences containing messages: 700
Number of Conferences listed in the View List menu: 3000
Maximum Conference Number 9999
Number of Messages per Conference 700
Number of Replies 700
Number of TagLines displayed in the list box 1000
Maximum Number of Lines in a message 400
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